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Chapter 1

Introduction

 This chapter includes the following sections:

� About This Document

� Integration Server Support

� Transport Support

� Settings for Integration Servers

� Supported Platforms

� Disk Space and Memory Requirements

� New Era of Networks Adapter for Flat Files Documentation Set

� Product Support & Education
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Chapter 1
About This Document
This document describes how to install New Era of Networks Adapter for Flat Files for the first 
time. To upgrade a current installation of New Era of Networks Adapter for Flat Files, contact 
Technical Support as shown in the section below, Product Support & Education on page 6.

The primary user of this document is the integration systems engineer who is responsible for the 
installation of New Era of Networks Adapter for Flat Files. 

This guide is organized into the following chapters:

� Chapter 1: Introduction lists supported integration servers, platforms and databases, disk space 
and memory requirements, and provides documentation, technical support and product 
education information.

� Chapter 2: Windows Server Installation provides steps to prepare for and run an installation on 
Windows and verify the environment variables.

� Chapter 3: Solaris Installation details the steps to prepare for and run an installation on Solaris 
and verify the environment variables.

� Chapter 4: HP-UX Installation provides steps to prepare for and run an installation on HP-UX 
and verify the environment variables.

� Chapter 5: AIX Installation outlines the steps to prepare for and run an installation on AIX and 
verify the environment variables.

� Chapter 6: Uninstalling New Era of Networks Adapter for Flat Files provides the steps for 
uninstalling the product from the server.

� Glossary contains a Glossary listing terms used in describing adapters.

Integration Server Support
New Era of Networks Adapter for Flat Files is compatible with the following integration servers:

� e-Biz Integrator, versions 3.2, 3.6 

� MQSeries Integrator, versions 2.0.1, 2.0.2

� WebSphere MQ Integrator, version 2.1

� e-Biz 2000, version 3.4.1

Transport Support
New Era of Networks Adapter for Flat Files uses Open Transport (OT) 2.3. Open Transport 2.3 
supports the following transports:

� e-Biz 2000 Driver for Open Transport 2.3

� EMQ Driver for Open Transport 2.3

� File Driver for Open Transport 2.3

� MQSeries Driver for Open Transport 2.3

� MSMQ Driver for Open Transport 2.3
2 New Era of Networks Adapter for Flat Files
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Introduction
Settings for Integration Servers
The following table provides information that you need when setting up your configuration files. 
Knowing the driver, schema loader, and serializer that is used with your integration server guides 
you in selecting configuration keys for your configuration files. 

Integration Server
Open Trans-
port Driver

Schema Loader Serializer

e-Biz Integrator 3.2, 3.6 EMQ
MQSeries 
(use RFH2)
MSMQ
File

NNT54 Schema-
Loader

NCFSerializer
XMLSerializer

MQSI 2.0.1,2.0.2 MQSeries 
(use RFH2)

NNT54 Schema-
Loader

NCFSerializer
XMLSerializer

WMQI 2.1 MQSeries 
(use RFH2)

NNT54 Schema-
Loader

NCFSerializer
XMLSerializer

e-Biz 2000 3.4.1 e-Biz 2000 eBizSchemaPlugin XMLSerializer
New Era of Networks Adapter for Flat Files 3
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Chapter 1
Supported Platforms

Server

Disk Space and Memory Requirements
Installation Media: CD-ROM

Server Requirements
Disk space: 50 MB for New Era of Networks Adapter for Flat Files executables

Memory: 256 MB.

Operating System DBMS Compiler

Windows NT 4.0 
(Service Pack 5 or 
higher)
Windows 2000 
(Service Pack 2 or 
higher)

Microsoft SQL Server 6.5
Microsoft SQL Server 7
Microsoft SQL Server 2000
Oracle 8.0.x
Oracle 8.1.6
Oracle 8.1.7
DB2 UDB 6.2

Microsoft Version 6.0 C++

Solaris 7 Sybase ASE 11
Sybase ASE 12

SparcWorks 4.2 C++

HP-UX 11 Oracle 8.0.x
Oracle 8.1.6
Oracle 8.1.7

HP C++A 10.34

IBM AIX 4.3.2, 
4.3.3

Oracle 8.0.x
Oracle 8.1.6
Oracle 8.1.7
DB2 UDB 6.2

VisualAge C++Professional 
for AIX Version 5
4 New Era of Networks Adapter for Flat Files
Installation Guide



Introduction
New Era of Networks Adapter for Flat Files Documentation Set
This section describes the available documentation.

Cross-Platform Documentation
The New Era of Networks Adapter for Flat Files documentation set includes:

� Installation Guide

� User Guide

� Feature Guide

� Release Bulletin

Related Documentation
The following documents are referenced in this document set to supply you with specific 
information that supports this product:

� MQSeries Driver for Open Transport Configuration Guide

� MSMQ Driver for Open Transport Configuration Guide

� EMQ Driver for Open Transport Configuration Guide

� File Driver for Open Transport Configuration Guide

� e-Biz 2000 Driver for Open Transport Configuration Guide

Other related documentation is available from New Era of Networks, Sybase, and IBM. Refer to 
other documentation from each of these companies for more detail about use of applications 
relevant to this product.

To access the Technical Library Product Manuals Web site, go to Product Manuals at http://
www.sybase.com/support/manuals.
New Era of Networks Adapter for Flat Files 5
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Chapter 1
Document Conventions
The following document conventions are used in this guide.

Product Support & Education
For more information on Support Services, education, and consulting services, refer to the 
Customer Services Reference Guide.

Text Convention Example

code courier <user ID> <password>

command line display courier The message successfully 
parsed.

command line entry courier bold NNFAD-t

command line prompt courier Enter the input file name:

book names bold, italic User Guide

chapter and section 
names

italic NT Installation
6 New Era of Networks Adapter for Flat Files
Installation Guide



Chapter 2

Windows Server Installation

This chapter describes how to prepare for and run an  installation on a 
Windows NT server. It includes the installation of all components. Once 
installed, New Era of Networks Adapter for Flat Files can be used with a 
New Era of Networks Rules and New Era of Networks Formatter repository.

This chapter includes the following:

� Preparing for a Windows Installation

� Installing New Era of Networks Adapter for Flat Files

� Verifying Environment Variables

The steps to follow after installing the server files are:

� Verifying the installation by ensuring all the necessary sub-directories 
are in place using the procedures documented at the end of the 
installation chapter.

� Configuring your adapter using the New Era of Networks Adapter for 
Flat Files User Guide.
New Era of Networks Adapter for Flat Files 7
Installation Guide



Chapter 2
Preparing for a Windows Installation
This section presents the steps you should take before you run the installation procedure:

� Installing Required Software

� Verifying the Database Environment

� Uninstalling Previous Releases

NOTE:
Review the printed Release Bulletin included with this package for any last-minute updates to this 
Installation Guide.

Installing Required Software
Supported Platforms on page 4 identifies the operating systems, DBMS applications, and 
compilers required for this product. Use that table to identify which software is required for this 
installation.

At the minimum you need the following software installed on your server:

� Windows operating system.

� DBMS software for storage of formats on the integration server.

� Compiler if you plan to write any of your own code.

� One of the integration servers listed in Integration Server Support on page 2.

Verifying the Database Environment
New Era of Networks Adapter for Flat Files accesses a designated database through the integration 
engine on the server where the integration server resides. Verify that you can connect to this 
database before installing the New Era of Networks Adapter for Flat Files software. For additional 
information about the integration server database environment, see the Installation Guide for the 
integration server.

Uninstalling Previous Releases
If you currently have a previous release of New Era of Networks Adapter for Flat Files installed, 
you may want to uninstall that version before installing the current release. Installation of the 
current release does not overwrite the previous installation and does not affect any files you may 
have added.
8 New Era of Networks Adapter for Flat Files
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Windows Server Installation
Installing New Era of Networks Adapter for Flat Files
It is recommended that you perform a typical installation, which automatically installs all 
components and their dependencies.

To install New Era of Networks Adapter for Flat Files using the InstallShield Wizard:

1. Insert the CD into the CD-ROM drive and do one of the following:

� If your machine is configured to autorun from the CD-ROM, the InstallShield Wizard 
automatically starts. 

� If your machine is not configured to autorun from the CD-ROM, do the following:

a.Choose Start→Run from the Windows Start menu.

b.In the Run dialog box, browse to locate the following file:

       <CD drive>:\n6nrf54_<*>\Setup.exe

The New Era of Networks Components Installer window appears.

2. Carefully read the License Agreement that appears and respond to it appropriately.

3. To begin the installation process, click Next.

The Install New Era of Networks Components window appears.

4. To select components for installation, choose one of the following:

� To accept the default installation (all components), click Next.

� To install only selected components, deselect the components you do not want to install, 
and click Next.

The Setup Type window appears.

NOTE:
Install all components to make full use of the product. If you are reinstalling one of 
the components, deselect the components that you do not want to install, and click 
Next. 
New Era of Networks Adapter for Flat Files 9
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Chapter 2
5. The Setup Type window appears for each component being installed. The options are:

� Typical install for all components?

� Customize selected component installs?

The default and preferred method to install the full group of packages is Typical. 

To complete the installation process and restart your computer, click Finish.

If you select: Then:

Typical install 1. Click Next to begin the installation of all product 
components.

2. Click Next on the Select Components Root Path window to 
accept the default location for the installation and its 
dependencies.The default location is: 

 C:\nnsy 

This is the default location for all New Era of Networks products.

3. The Setup Status window appears for each component 
installation.

After component installation is complete, the following 
prompt appears:

Install default New Era of Networks database schema now?

Custom install 1. The Setup type window appears for each component being 
installed. The options are:

� Typical - installing all of the required parts of the 
component.

� Compact - installing the same as Typical except that the 
documentation is not installed.

� Custom - allowing the user to decide what parts of the 
component to install.

The default and preferred method is Typical. Click Next to 
begin the installation of that component.

2. Click Next to accept the selected setup type for each 
component when the window appears.

3. After each component is installed, the Select Components 
Program Folder appears for identification of the Start menu’s 
program folder. It is suggested that all New Era of Networks 
products appear under the default folder of:

New Era of Networks

4. Click Next to accept the default folder name.
10 New Era of Networks Adapter for Flat Files
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Windows Server Installation
Verifying the Installation
Verify that the following sub-directories are installed for New Era of Networks Adapter for Flat 
Files.

            C:\nnsy\

Subdirectory Description

bin\ executable and shared libraries for New Era of Net-
works products

books\ user documentation

ffa38\examples\ sample makefile and configuration files

ffa38\nnscripts\ used for AWK scripts

share\ resources for XML serializer/deserializer

NNSYCatalogues\en_US language designation and message catalogues
New Era of Networks Adapter for Flat Files 11
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Chapter 2
Verifying Environment Variables
The Windows installation process for New Era of Networks products automatically sets the system 
environment variables as described in the following table.

To verify that the environment variables are correctly set:

1. Go to Settings→Control Panel→System. 

2. Select the Environment tab.

3. Use the information provided in the following table to verify that the values are correct.

Variable Value

NNSY_ROOT C:\nnsy

ICU_DATA C:\nnsy\share\icu\data

PATH Includes:
� C:\nnsy\bin

� MQSeries bin directory, typically C:\MQM\BIN
12 New Era of Networks Adapter for Flat Files
Installation Guide



Chapter 3

Solaris Installation

This chapter describes how to prepare for and run an  installation on Solaris. 
It includes the installation of all components.

The installation process includes the following procedures:

� Preparing for a Solaris Installation

� Installing New Era of Networks Adapter for Flat Files

� Setting Environment Variables

After installing the server files, the post-installation process includes:

� Verifying the installation by ensuring all the necessary sub-directories 
are in place using the procedures documented at the end of the 
installation chapter.

� Configuring your adapter using the New Era of Networks Adapter for 
Flat Files User Guide.
New Era of Networks Adapter for Flat Files 13
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Chapter 3
Preparing for a Solaris Installation
This section presents the steps you should take before you run the installation procedure:

� Installing Required Software

� Verifying the Database Environment

� Uninstalling Previous Releases

NOTE:
Review the printed Release Bulletin included with this package for any last-minute updates to this 
Installation Guide.

Installing Required Software
Supported Platforms on page 4 identifies the operating systems, DBMS applications, and 
compilers required for this product. Use the table in that section to identify which software is 
required for installation.

On the server, you need the following:

� Solaris operating system 

� DBMS server database application

� Compiler (if you plan to write any of your own code).

Verifying the Database Environment 
New Era of Networks Adapter for Flat Files accesses a designated database through the integration 
engine where the integration server resides. Verify that you can connect to this database before 
installing the New Era of Networks Adapter for Flat Files software. For additional information 
about the integration server database environment, see the Installation Guide for the integration 
server.

Uninstalling Previous Releases
If you currently have a previous release of New Era of Networks Adapter for Flat Files installed, 
you may want to uninstall that version before installing the current release. Installation of the 
current release does not overwrite the previous installation and does not affect any files you may 
have added.
14 New Era of Networks Adapter for Flat Files
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Solaris Installation
Installing New Era of Networks Adapter for Flat Files
If you are installing the product for the first time, accept the default setting to install all packages. 
This selection installs all components and associated dependencies and allows you to make full use 
of the product. Use the option to install selected packages only if you are reinstalling a specific 
component. 

To start pkgadd and install New Era of Networks Adapter for Flat Files:

1. Log in as root.

2. Change to the directory where the CD-ROM is mounted. 

3. To begin the installation, type the following and press ENTER:

       pkgadd -d ./nnsy

The package selection screen displaying the components available for installation appears.

4. At the prompt, do one of the following:

� To accept the default (all packages), press ENTER. 

� To install selected packages, type the numbers of the packages you want to install. 
Separated each entry with a comma (for example: 3, 4, 7, 10, 14) and press ENTER.

NOTES:
If you are installing the product for the first time, install all components to make full use of 
the product. 

If you are reinstalling a component, identify the specific component package. 

The installation program begins processing and a verification screen appears for each 
component. 

5. At the following prompt, type Y (Yes) or N (No) and press ENTER to confirm the installation 
of each component:

Do you want to continue with the installation of <component name>?

The following message appears to confirm the installation of each component:

Installation of <component name> was successful.

The package selection screen reappears after installation of all components is complete.

6. In the Package Selection screen, type q and press ENTER to quit the installation program. 

7. Verify that the following sub-directories are installed for <product install>.
New Era of Networks Adapter for Flat Files 15
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            /opt/nnsy/

Setting Environment Variables
After installation and before installing the database schema, you must create the environment 
variables identified in the following table. 

To set the environment variables:

Choose one of the following:

� Add each variable to your profile using the command in the table.

� Enter the information on the command line each time you start and executable. 

WARNING!
When you are making changes to the paths, type the following to prevent overwriting all data 
currently in the path:

For PATH:

export PATH=$NNSY_ROOT/bin:$PATH

Subdirectory Description

bin/ Executables and shared libraries for New Era of 
Networks products. Any specifically applicable to 
SQL will be located in the NNmssql65\ subdirectory 
of bin.

books/ User documentation in PDF format for online view-
ing. This documentation is formatted for best view-
ing on-screen but may be printed if desired.

share/ Resources for XML serializer/deserializer.

ffa38/examples/ sample configuration files

ffa38/nnscripts/ Used for AWK scripts.

NNSYCatalogues/en_US Message catalogues (by country) for log file entries.
16 New Era of Networks Adapter for Flat Files
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Solaris Installation
New Era of Networks Product Environment Variables

Verifying the Environment Variables
Using the env command, verify that the system variables for your operating environment are set 
properly:

� New Era of Networks product environment variables identified in New Era of Networks 
Product Environment Variables on page 17.

Variable Command Syntax

NNSY_ROOT export NNSY_ROOT=/opt/nnsy

ICU_DATA export ICU_DATA=/opt/nnsy/share/icu/data

PATH export PATH=/opt/nnsy/bin/:$PATH

LD_LIBRARY_PATH export LD_LIBRARY_PATH=/opt/nnsy/bin/
:$LD_LIBRARY_PATH
New Era of Networks Adapter for Flat Files 17
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Chapter 4

HP-UX Installation

This chapter describes the steps to prepare for and run an installation on HP-
UX.

The installation process includes the following procedures:

� Preparing for an HP-UX Installation

� Installing New Era of Networks Adapter for Flat Files

� Setting Environment Variables

After installing the server files, the post-installation process includes:

� Verifying the installation by ensuring all the necessary sub-directories 
are in place using the procedures documented at the end of the 
installation chapter.

� Configuring your adapters using the New Era of Networks Adapter for 
Flat Files User Guide.
New Era of Networks Adapter for Flat Files 19
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Chapter 4
Preparing for an HP-UX Installation
This section presents the steps you should take before you run the installation procedure:

� Installing Required Software

� Verifying the Database Environment

� Uninstalling Previous Releases

NOTE:
Review the printed Release Bulletin included with this package for any last-minute updates to this 
Installation Guide.

Installing Required Software
Supported Platforms on page 4 identifies the operating systems and DBMS applications required 
for this product. Use that table to identify which software is required for installation.

At the minimum you need the following software installed on your server:

� HP-UX operating system 

� DBMS server database application

� Compiler (if you plan to write any of your own code).

Verifying the Database Environment 
New Era of Networks Adapter for Flat Files accesses a designated database through the integration 
server. Verify that you can connect to this database before installing the New Era of Networks 
Adapter for Flat Files software. For additional information about the integration server database 
environment, see the Installation Guide for the integration server.

Uninstalling Previous Releases
If you currently have a previous release of New Era of Networks Adapter for Flat Files installed, 
you may want to uninstall that version before installing the current release. Installation of the 
current release does not overwrite the previous installation and does not affect any files you may 
have added.

Installing New Era of Networks Adapter for Flat Files
If you are installing the product for the first time, accept the default setting to install all 
components. This selection installs all associated component dependencies and allows you to make 
full use of the product. Use the option to install selected components only if you are reinstalling a 
specific component. 

To install New Era of Networks Adapter for Flat Files using swinstall:

1. Log in as root.

2. Insert the CD into the CD-ROM drive and mount it to the appropriate directory.

Example:

mount -r-o cdcase -F cdfs/dev/fsk/c1t2d0 /cdrom
Or simply:

mount /cdrom
3. If you are running in an X11 environment, set the DISPLAY environment variable.
20 New Era of Networks Adapter for Flat Files
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HP-UX Installation
Example:

export DISPLAY=xxx.xxx.xxx.xxx:0.0
4. To begin the installation operation, type the following and press ENTER:

swinstall
The SD Install Software Selection and the Specify Source windows appear.

5. In the Specify Source window, select CDROM and type the Source Host Name and Source 
Depot Path at Source Depot Type.

Source Depot Path example:

/{cdrom}/nnsy
where {cdrom} is the CD-ROM mounted in step 1.

6. Click OK. 

The Specify Source window closes, and the SD Install - Software Selection window becomes 
active.

7. Choose one of the following:

� To install all the components of New Era of Networks Adapter for Flat Files, select 
Actions→Mark for Install. 

� To install only selected components of New Era of Networks Adapter for Flat Files, do the 
following:

–Double-click New Era of Networks Adapter for Flat Files. The SD - Install Software 
selection window indicates that you are viewing Subproducts or Filesets: New Era of 
Networks Adapter for Flat Files and components are displayed.

–Select the components that you want to install.

–From the menu bar, select Actions→ Mark for Install.

–Double-click (go up) to return to the top. The SE Install - Software Selection window 
indicates you are viewing Top (Bundles and Products). 

TIP:
To simplify the component selection process, select all components, double-click New Era 
of Networks Adapter for Flat Files, deselect the components you do not want installed, 
and choose Actions→ Unmark for Install.

8. To change an install option, choose Options→Change Options.

9. To display the progress of the installation analysis, choose Actions→Install (analysis...). 

When the analysis is complete, the status displays Ready in the Install Analysis window.

If the analysis is not successful, an error window appears displaying the specific error. Do one 
of the following:

� To close the window, click OK.

� To adjust the component selections or other install options, click Cancel, close the Install 
Analysis window, and adjust your component selections using step 7 in this procedure. 

10. To review installation details:

� Click Logfile to view a log of the analysis. 

� Click Disk Space Analysis to view the disk space statistics.
New Era of Networks Adapter for Flat Files 21
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11. Click OK to continue. 

The Confirmation window appears.

12. Click Yes to start the installation. 

When the installation completes, the status displays Completed in the Install Window.

13. From the Install window, do any of the following to review installation details:

� Click Product Summary to view the installation status of components.

� Click Logfile to view a log of actions that occurred.

14. Click Done to close the Install Window.

15. Choose File→ Exit to close the SD Install - Software Selection window.

16. Verify that the following sub-directories are installed for e-Biz Integrator.

            /opt/nnsy/

Subdirectory Description

bin/ Executables and shared libraries for New Era of 
Networks products. Any specifically applicable to 
SQL will be located in the NNmssql65\ subdirectory 
of bin.

books/ User documentation in PDF format for online view-
ing. This documentation is formatted for best view-
ing on-screen but may be printed if desired.

share/ Resources for XML serializer/deserializer.

ffa38/examples/ sample configuration files

ffa38/nnscripts/ Used for AWK scripts.

NNSYCatalogues/en_US Message catalogues (by country) for log file entries.
22 New Era of Networks Adapter for Flat Files
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Setting Environment Variables
After installation and before installing the database schema, you must create the environment 
variables identified in the following table. 

To set the environment variables:

Choose one of the following:

� Add each variable to your profile using the command in the table.

� Enter the information on the command line each time you start and executable. 

New Era of Networks Product Environment Variables

WARNING!
When you are making changes to the paths, type the following (Korn Shell examples) to prevent 
overwriting all data currently in the path:

For PATH:

export PATH=$NNSY_ROOT/bin:$PATH

For SHLIB_PATH:

export SHLIBPATH=$NNSY_ROOT/BIN:$SHLIBPATH

Verifying the Environment Variables
Using the env command, verify that the system variables for your operating environment are set 
properly:

� New Era of Networks product environment variables identified in the New Era of Networks 
Product Environment Variables table.

Variable Command Syntax

NNSY_ROOT export NNSY_ROOT=/opt/nnsy

ICU_DATA export ICU_DATA=/opt/nnsy/share/icu/data

PATH export PATH=/opt/nnsy/bin/:$PATH

LD_LIBRARY_PATH export LD_LIBRARY_PATH=/opt/nnsy/bin/
:$LD_LIBRARY_PATH
New Era of Networks Adapter for Flat Files 23
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AIX Installation

This chapter describes how to prepare for and run an  installation on AIX. It 
includes the installation of all components.

The installation process includes the following procedures:

� Preparing for an AIX Installation

� Installing New Era of Networks Adapter for Flat Files

� Setting Environment Variables

After installing the server files, the post-installation process includes:

� Verifying the installation by ensuring all the necessary sub-directories 
are in place using the procedures documented at the end of the 
installation chapter.

� Configuring the system as described in the User Guide.
New Era of Networks Adapter for Flat Files 25
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Preparing for an AIX Installation
This section describes the steps you should take before you run the installation procedure:

� Installing Required Software

� Verifying the Database Environment

� Uninstalling Previous Releases

NOTE:
Review the printed Release Bulletin included with this package for any last-minute updates to this 
Installation Guide.

Installing Required Software
Supported Platforms on page 4 identifies the operating systems and DBMS applications required 
for this product. Use this table to identify which software is required for installation.

At the minimum you need the following software installed on your server:

� AIX operating system 

� DBMS server database application

Verifying the Database Environment 
New Era of Networks Adapter for Flat Files accesses a designated database through the integration 
server. Verify that you can connect to this database before installing the New Era of Networks 
Adapter for Flat Files software. For additional information about the integration server database 
environment, see the Installation Guide for the integration server.

Uninstalling Previous Releases
If you currently have a previous release of New Era of Networks Adapter for Flat Files installed, 
you may want to uninstall that version before installing the current release. Installation of the 
current release does not overwrite the previous installation and does not affect any files you may 
have added.
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Installing New Era of Networks Adapter for Flat Files
If you are installing the product for the first time, accept the default setting to install all packages. 
This selection installs all components and associated dependencies and allows you to make full use 
of the product. Use the option to install selected packages only if you are reinstalling a specific 
component. 

NOTE:
To avoid overwriting any adapter files, install your integration server before you install New Era of 
Networks Adapter for Flat Files.

Installing New Era of Networks Adapter for Flat Files on AIX is a two-part process: mounting a 
directory on AIX and starting installp.

To mount a directory on AIX:

1. Insert the CD into the CD-ROM drive and mount it to the appropriate directory.

Example:

 /mnt/cdrom

2. Set the DISPLAY variable to use the System Management Interface Tool (SMIT) GUI.

3. From the command line, type smit. 

The SMIT GUI appears.

4. Click System Storage Management.

5. Click File Systems.

6. Click Mount A File System.

7. Respond to each of the prompts listed in the following table:

SMIT Prompt Response

File System Type the name of the file system
or
Select a file system from the list box

Directory over which to 
mount?

Enter your installation source directory. 

Enter this directory again when you receive the installation 
prompt:
INPUT device/directory for software
Note: The default is blank.

Type of File System? Type the name of the file system
or
Select a file system from the list box

Force the mount? Type No (default) if the mount point already exists.
Type Yes to force the mount. If the mount point already exists, it 
will be corrupted.

Remote node containing 
the file system to mount?

Type a value. 
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8. To execute the mount command, click OK.

9. When the mount has succeeded, click Done.

10. Return to the SMIT System Management window.

To start installp:

To install New Era of Networks Adapter for Flat Files, the system administrator must add an mqm 
group and user name.

1. From the SMIT System Management window, choose from the following options:

� Software Installation and Maintenance

� Install and Update Software

� Install and Update from LATEST available Software

� INPUT device/directory for software 

2. At the following SMIT prompts, do one of the following:

� Accept a default response or type your response in the box.

� Click LIST to customize your selection.

Mount as a removable file 
system?

Type Yes if you are using a removable drive. Type No if you are 
not.

Mount as a Read Only 
system?

Type Yes to mount as a read only system.

Disallow device access 
via this mount?

Type Yes to disallow device access.
Type No to allow device access.

Disallow execution of suid 
and sqid programs in this 
file system?

Type Yes to disallow execution of suid and sqid programs.
Type No to allow execution of suid and sqid programs.

SMIT Prompt Response

SOFTWARE to install Type_all_latest to install all components.

PREVIEW only? Click No.
If you click Yes, the install operation will not occur.

COMMIT software 
updates?

Click Yes.

SAVE replaced files? Click No.

AUTOMATICALLY install 
requisite software?

Click YES. To install New Era of Networks Adapter for 
Flat Files, choose Yes at this prompt. You must then 
select No at the OVERWRITE same or newer ver-
sions? prompt.

SMIT Prompt Response
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3. Click OK to continue. 

4. At the following prompt, click OK:

ARE YOU SURE? 

As the installation program runs, the status is displayed in an installation log.

5. Do one of the following:

� If the status changes to OK, the installation is successful. Click Done to continue.

� If the status changes to Failed, correct the failure and repeat steps 1-5.

6. To quit SMIT, click Exit.

7. Verify that the following sub-directories are installed for New Era of Networks Adapter for 
Flat Files.

            /usr/lpp/nnsy/

EXTEND file systems if 
space needed?

Click Yes.
If you already chose Yes for the AUTOMATICALLY 
install requisite software? prompt, click No.

OVERWRITE same or 
newer versions?

Click No.
You can not choose the same response as you chose 
for AUTOMATICALLY install requested software?

VERIFY install and check 
file sizes?

Click Yes.

Include corresponding 
LANGUAGE filesets?

Click No.

Detailed output? Click Yes.

(For AIX Version 4.3)
Process multiple vol-
umes?

Click No.

Subdirectory Description

bin/ Executables and shared libraries for New Era of 
Networks products. Any specifically applicable to 
SQL will be located in the NNmssql65\ subdirectory 
of bin.

books/ User documentation in PDF format for online view-
ing. This documentation is formatted for best view-
ing on-screen but may be printed if desired.

share/ Resources for XML serializer/deserializer.

ffa38/examples/ sample configuration files

ffa38/nnscripts/ Used for AWK scripts.

NNSYCatalogues/en_US Message catalogues (by country) for log file entries.

SMIT Prompt Response
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Setting Environment Variables
After installation and before installing the database schema, you must create the environment 
variables identified in the following table. 

To set the environment variables:

Choose one of the following:

� Add each variable to your profile using the command in the table.

� Enter the information on the command line each time you start an executable. 

New Era of Networks Product Environment Variables

WARNING!
When you are making changes to the paths, type the following to prevent overwriting all data 
currently in the path:

For PATH:

export PATH=$NNSY_ROOT/BIN:$PATH

For LIB_PATH:

export LIBPATH=$NNSY_ROOT/BIN:$LIBPATH

Verifying the Environment Variables
Using the env command, verify that the system variables for your operating environment are set 
properly:

� New Era of Networks product environment variables identified in New Era of Networks 
Product Environment Variables on page 30.

Variable Command Syntax

NNSY_ROOT export NNSY_ROOT=/usr/lpp/nnsy

ICU_DATA export ICU_DATA=/usr/lpp/nnsy/share/icu/data

NNSY_CATALOGUE export NNSY_CATALOGUE=/usr/lpp/nnsy/NNSYCata-
logues/<locale name>

PATH export PATH=/usr/lpp/nnsy/bin/:$PATH

LIBPATH export LIBPATH=/usr/lpp/nnsy/bin/:$LIBPATH
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Uninstalling New Era of 
Networks Adapter for Flat Files

This chapter describes how to uninstall a previous version of New Era of 
Networks Adapter for Flat Files from a Windows, Solaris, HP-UX, or AIX 
server.
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Uninstalling from a Windows Server
Before uninstalling New Era of Networks Adapter for Flat Files, you must manually delete all user 
files. The InstallShield wizard removes only the files and directories that were put there by the 
InstallShield.

To uninstall New Era of Networks Adapter for Flat Files components on Windows

1. From the Windows Control Panel, choose Add/Remove Programs.

2. Select the Install/Uninstall tab. 

3. Scroll down and select New Era of Networks Component Installer. 

4. Click Add/Remove. 

The Components Installer window of InstallShield appears.

5. Click Next on the New Era of Networks Components Installer Welcome window to select the 
New Era of Networks Adapter for Flat Files components to remove or reinstall. 

6. Select the following components from the list:

� New Era of Networks Adapter for Flat Files (n9ffa38)

� New Era of Networks Adapter for Flat Files Documentation 380 (n0ffa38b)

7. ONLY if you have no other New Era of Networks products installed, delete all of the 
components in the directory.

NOTE:
If you have multiple New Era of Networks products installed on your machine, the 
Component Installer displays all the products.

Select All allows maintenance on New Era of Networks Adapter for Flat Files and any 
other New Era of Networks component listed. This may include adapters, New Era of 
Networks Formatter, and New Era of Networks Rules components.

If you do not select all components and other components rely on a selected component, a 
warning message appears.

      "xxxx depends on yy."
      If you choose to remove yy, xxxx will become inoperative.

The Setup Type window appears for each component being removed. The options are:

� Perform maintenance on components.

This option enables removal of parts of each component or reinstallation of program 
components.

� Remove all selected components.

This option bypasses any modification or repair options and performs an immediate 
removal of the selected components.

8. Select Remove all selected components to uninstall the selected components of New Era of 
Networks Adapter for Flat Files and click Next.

9. Respond to the following window prompts if you are performing Maintenance on components:

a. The Maintenance window appears to identify the action to remove or reinstall the first 
selected component. The options are:
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� Modify - select some or all of the parts of the selected component to uninstall.

� Repair - reinstall the selected program components.

� Remove - uninstall the selected program components.

The default method is Modify. 

b. Select Remove to delete all of the selected components and click Next.

c. Click OK on the confirmation prompt to completely remove the selected application and 
all of its components.

d. After removal of the first component, the Maintenance window appears to identify the 
action for the next component.

e.  Repeat steps b and c for each component.

10. When all selected components are uninstalled, click Finish.

11. Close the Add/Remove Programs Properties window.

12. Check the C:\WINNT\nnsycomp.ics file to make sure that all components and dependencies 
were removed.

13. Go to Windows Explorer and verify that the files for the deleted components are removed from 
the nnsy directories.

If all New Era of Networks products have been removed, leaving the nnsy directory empty, 
you must physically delete the nnsy directory to remove it from the drive.
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Uninstalling from Solaris 

To uninstall New Era of Networks Adapter for Flat Files from Solaris:

1. Login as root. 

2. Use one of the following methods to view all software that is installed on your machine:

� At the command prompt, type pkginfo <package name> and press Enter.

� At the command prompt, type pkgrm <package name> and press Enter.

NOTES:
If you have multiple New Era of Networks products installed on your machine, the 
Component Installer displays all the products.

Select All allows maintenance on New Era of Networks Adapter for Flat Files and any 
other New Era of Networks component listed. This may include adapters, New Era of 
Networks Formatter, and New Era of Networks Rules components.

3. Select the following components from the list for removal:

� NNSY Flat File Adapter 380_n (n9ffa38)

� NNSY Flat File Adapter Documentation 380_n (n0ffa38b)

4. ONLY if you have no other New Era of Networks products installed, delete all of the 
components in the directory.

5. The following message appears:

Do you want to remove this package?

6. Type Y and press enter.

When the component is removed, the following message appears:

Removal of <package name> was successful.
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Uninstalling from HP-UX

To uninstall New Era of Networks Adapter for Flat Files from HP-UX:

1. Log on as root.

2. Type swremove. 

The SD Remove Software Selection window appears.

NOTES:
If you have multiple New Era of Networks products installed on your machine, the 
Component Installer displays all the products.

Select All allows maintenance on New Era of Networks Adapter for Flat Files and any 
other New Era of Networks component listed. This may include adapters, New Era of 
Networks Formatter, and New Era of Networks Rules components.

3. Select the following components from the list for removal:

� New Era of Networks Adapter for Flat Files (n9ffa38)

� New Era of Networks Adapter for Flat Files Documentation 380 (n0ffa38b)

4. ONLY if you have no other New Era of Networks products installed, delete all of the 
components in the directory.

5. From the menu bar, select Actions→ Mark for Remove. 

6. Select Actions→ Remove (analysis...). 

The Remove Analysis window appears. When the analysis is complete, the status reads Ready.

7. To view a log of the analysis, click Logfile, and to view the product components, click 
Product Summary. Click Done to exit either window.

8. To begin the uninstall, click OK. The Confirmation window appears.

9. To uninstall, click OK. 

The Remove Window appears displaying the status of the uninstallation. When the uninstall is 
complete, the status reads Completed.

10. To view a log of the uninstall, click Logfile. Click Done to exit.

11. To close the SD Remove - Software Selection window, choose File→ Exit.
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Uninstalling from AIX

To uninstall New Era of Networks Adapter for Flat Files from AIX:

1. Log on as root.

2. Type smit. 

The main SMIT window appears.

3. From the SMIT window, choose Software Installation and Maintenance.

4. Choose Software Maintenance & Utilities→Remove Installed Software.

The Remove Installed Software window appears. Verify that the following options are 
displayed:

NOTES:
If you have multiple New Era of Networks products installed on your machine, the 
Component Installer displays all the products.

Select All allows maintenance on New Era of Networks Adapter for Flat Files and any 
other New Era of Networks component listed. This may include adapters, New Era of 
Networks Formatter, and New Era of Networks Rules components.

5. Select the following components from the list for removal:

� New Era of Networks Adapter for Flat Files (n9ffa38)

� New Era of Networks Adapter for Flat Files Documentation 380 (n0ffa38b)

6. ONLY if you have no other New Era of Networks products installed would you delete all of 
the components in the directory.

7. From the Remove Installed Software window, click OK. 

A Confirmation window appears asking ARE YOU SURE?

8. Click OK.

Option Value

Name of Software To remove New Era of Networks Adapter for 
Flat Files, select New Era of Networks 
Adapter for Flat Files.

Preview only? No 
Yes provides a preview of what you might 
remove if “No” is selected.

Remove Dependent Soft-
ware

No (default)

Extend the File System if 
space needed?

No (default)
It should not be necessary to specify Yes.

Detailed output? Yes, if you want verbose remarks.
No results in minimum messaging.
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After the uninstall is complete, remarks are displayed in the output section of the Remove 
Installed Software window. You can scroll to view remarks for all of the software removed. To 
exit this window, click Done, and then Cancel.

TIP:
Multiple packages can be removed simultaneously. In the Name of Software field, either 
type each package (separated by a space) that you want to remove or use the List option to 
select the packages.
New Era of Networks Adapter for Flat Files 37
Installation Guide



Chapter 6
38 New Era of Networks Adapter for Flat Files
Installation Guide



Glossary

abend

Acronym for abnormal end. More commonly known as a crash.

accelerator keys

A combination of keystrokes that bypasses the menu system to carry out an 
action.

action

An action defines a function to perform in a subscription. The Reformat and 
Put Message actions are predefined and the user can provide generic actions 
as well. An action must contain at least one option name-value pair.

administration workstation

A form of “client” from which a user carries out New Era of Networks 
Rules, Formatter, and Messaging management duties.

alternative format

A special form of compound format where one format in a set of alternatives 
applies to a message. For example, if the alternative format is named A, it 
may contain component formats B, C, and D. A message of format A may 
actually be a variation of B, C, or D.

application group

A logical grouping of applications used to organize rules.

Application Program Interface (API)

The interface (calling conventions) by which an application program 
accesses services. An API is defined at source code level and provides a 
level of abstraction between the application and the kernel (or other 
privileged utilities) to ensure portability of the code. A New Era of Networks 
Rules, Formatter, and Messaging API refers to a set of object classes, 
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structures, and functions that can be used by an application program to 
invoke New Era of Networks Rules, Formatter, and Messaging services. 
Plural: APIs.

argument

In the New Era of Networks Rules GUI, an argument is evaluation criteria made up of fields from a 
message and associated operators.

ASCII

Abbreviation for American Standard Code for Information Interchange.

asynchronous

In electronic messaging, a method of operation in which receiving applications are loosely coupled 
and independent. The receiver need not respond immediately to a message, and the sender does not 
have to wait for a response before proceeding with the next operation. Compare to synchronous.

Boolean operators

Boolean logic allows for compound conditional statements, using logical operators including AND 
and OR.

client

A system or process that requests a service from another system or process.

client-server

A paradigm for distributed computing under which the system is split between one or more server 
tasks which accept requests according to some protocol, and client tasks which request information 
or actions. Clients and servers can be placed independently on network nodes.

cross-platform

Used to describe programs that can execute in dissimilar computing environments.

data type

Describes how to interpret the data.

DBMS

Abbreviation for Database Management System.

delimiter

One or more characters marking either the beginning or end of a field of data.

daemon

In UNIX, a program that executes in the background. Also known as agents, daemons only activate 
when defined system conditions become true. For example, a daemon may activate when the 
system clock reaches 2:00 a.m. every other Saturday. Another daemon may activate when the 
system senses the arrival of e-mail.

field

The smallest possible container for information. You can use a field in more than one table. If the 
first_name field exists in one table, for example, you can use the same field in other tables.
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get

A request for the next message in a queue. Compare to put.

GUI

Abbreviation for graphical user interface.

heterogeneous

Composed of different parts of different kinds. Having dissimilar constituents.

hex

Hexadecimal means 16. The base 16 numbering system is used to represent binary numbers.

literal

One or more symbols or letters in data that represents itself.

massive mirroring

Massive mirroring is a means of boosting processing power by replicating entire databases on 
different computers and running them in parallel (keeping the databases synchronized).

message type

A message type defines the layout of a string of data. The message type name in the New Era of 
Networks Rules GUI is the same as the input format name in New Era of Networks Formatter.

middleware

Software intended to work between software applications and the underlying computer operating 
system.

option

An option consists of a name-value pair of data related to an action. An option name can be 
predefined (for Reformat and Put Message) or user-defined. 

parse

To analyze a message by breaking it down into its component fields.

permission

Rules and subscriptions are associated with user permissions that determine whether a user can 
change the item definition or any part of it. The PUBLIC user includes any user of the system. Read 
permission is always granted. The user creating the rule or subscription is the Owner. The Owner 
can change ownership to another user. Update permission is needed to modify component 
definition.

persistence

The ability of a computerized system to remember the state of data or objects between executions.

popup menu

A floating list of actions. To open a popup menu, right-click an object; the available actions depend 
on the object.
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protocol

A set of rules that govern the transmission and reception of data.

put

A request to store a message in a queue. Compare to get.

regular expression

Strings which express rules for string pattern matching. 

rule 

A rule is uniquely defined by its application group, message type, and rule name. It contains 
evaluation criteria (a rules expression) and is associated with subscriptions to perform if the rule 
evaluates to true. Rules also have permissions that determine user access.

scalable, scalability

Changeable in size and configuration. The ability to expand, implying minimal procedural change 
to accommodate growth. 

server

A computer that, through its network connections, carries out parts of computing tasks for other 
networked computers. 

shared subscription

A subscription that is associated with more than one rule. This subscription will only be retrieved 
once by the Rules APIs even if multiple associated rules evaluate true.

subscription

A subscription is uniquely identified by its application group, message type, and subscription name. 
It contains actions with options and can be associated with one or more rules. Subscriptions also 
have permissions that determine user access to change the subscription definition.

synchronous

In electronic messaging, a method of operation in which sender and receiver applications are tightly 
coupled and dependent. The receiver must answer the sender’s message immediately with a well-
defined response; the sender must wait for the receiver’s response before proceeding to the next 
operation. Compare to asynchronous.

table

A database remembers relationships between pieces of information by storing the information in 
tables. The columns and rows in each table define the relationships in a highly structured way. We 
can classify tables by function into two types: support tables and data tables. Most tables fit into 
only one category, but some can serve as both support and data tables. 

A support table stores information that changes infrequently and functions as a list from which you 
make selections. 

tag

A set of bits or characters that identify various conditions about data in a file. In New Era of 
Networks Formatter, a standard value indicating the field’s name.
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transaction 

 An activity or request. Additions, changes, and deletions are typical transactions stored in a 
computer.

transaction management

 A method of handling electronic messaging such that only committed messages are sent and only 
messages received and committed are considered delivered.

transaction processing

A method of handling computer operations in which the operations take place immediately upon 
receipt of the processing request. Also called real-time or online system. Compare to batch 
processing.
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